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Revision Notes

Date File Changes

3/4/02
by MHN

all Adjusted example, TOC, and index formats; applied consistent formats to all files; 
deleted superfluous colors and formats; adjusted colors; imported new logo.

9/23/02
by ELF

Title ▼ Fix: Argh--style names in this file do not match those in chapters. This 
should be fixed someday. (e.g., Bulleted instead of Bullet1)

▼ Added this Revision Notes table.

Overview ▼ Typographical conventions says italic is used for emphasis; this used bold in “do 
not” so I fixed it.

▼ Added Audience section.

▼ Changed hard-coded company names to use existing variables; changed 
variables to "SampleCo" as the company name.

▼ Added list of additional standard sources for more info on style and vocabulary.

▼ Changed typographical conventions list to a table instead of text; added a NOTE 
to the list.

▼ Minor phrasing changes.

General Ref ▼ Page numbers in Overview table used chapter-page# format. Fixed.

▼ Minor edits throughout.

▼ Acronyms/Abbreviations:
❖ Added examples of abbreviations and acronyms.
❖ Added General Guidelines subhead for abbreviations/acronyms.
❖ Added conditional notes about where a customizer might add company-

specific examples.
❖ Fix: The NoteText tag crowds the preceding paragraph. The Notegraf 

tag does not seem to allow text to be incorporated. Not sure how to use 
either of these appropriately.

❖ Added Note to acronym guidelines re online conversion.
❖ Added GIF and HTML to list of common acronyms that do not need to be 

spelled out.
❖ Added a Sample Capitalization Section subsection.

▼ Compound Words
❖ Changed heading to Hyphenation of Compound Words.
❖ Changed some Head2s.
❖ Replaced example “frame-to-mif converter” with “point-to-point protocol” 

because of capitalization issues; this might not be the ideal replacement.

▼ Index: Added a ton of guidelines and preferences. Needs winnowing and 
editing.

▼ Lists
❖ Capitalization: changed dog list from names to attributes, because names 

would already be capitalized.
❖ Somehow the examples in Numbered Lists had lost their numbers. Fixed. 

Also replaced example with better ones. Trust me.
❖ Added examples of nonparallel and parallel lists.
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9/23/02 
(cont.)

General Ref 
(cont.)

▼ Numbers
❖ Changed title to Numbers and Measurements.
❖ Added two new subsections, “Operators” and “Measurement Designations.”

▼ Punctuation
❖ Added section on apostrophes.
❖ Added subheads for Dashes.
❖ Added info on how to create em and en dashes.
❖ Added examples and another bullet to Quotation Marks.

▼ General Notes
❖ Added explanation and expanded example for if vs. Whether.
❖ Replace active/passive example with several examples of each.

Terminology ▼ Terms to avoid, added:
❖ incentivize
❖ utilize
❖ via

▼ Split terms to avoid table into 2 tables and added intermediate text.

▼ Added subsections for Verbizing Nouns and Latin Terms.

▼ Added section on Localization.

▼ Added some terms.

Client-Specific ▼ Added list of possible topics.

Formatting ▼ Added new chapter This probably needs culling. 

Date File Changes
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Preface
Overview
This style guide contains a collection of writing and editing guidelines for producing 
consistent, good technical documents. 

Note: The Style Guide uses a few special formats for style examples. Do not use the Style 
Guide as a template!

Audience
This guide is for technical writers, marketing writers, engineers, and any other 
employees or contractors who develop documentation for our clients’ products. 
Apart from the formatting information in Chapter 4, “Formatting and Context 
Guidelines,” this guide does not assume knowledge of any particular document 
production system.

Section Page

Audience 1

Organization of This Guide 2

Typographical Conventions 2

Related Documentation 3
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Organization of This Guide
This guide includes the following sections.

Typographical Conventions
This guide uses the following typographical conventions to help you locate and 
identify information:

Chapter Description

Chapter 1,
“General Reference”

Information about

▼ Abbreviations and acronyms

▼ Capitalization

▼ Compound words

▼ Index

▼ Lists

▼ Numbers

▼ Personification

▼ Punctuation

▼ Additional grammar notes

Chapter 2,
“Terminology”

An alphabetic listing of terms to ensure consistency

Chapter 3,
“Client-Specific Conventions”

A chapter template wherein you can specify the 
conventions used in a particular document

Chapter 4,
“Formatting and Context 
Guidelines”

Formatting conventions including

▼ Cross references

▼ Chapters, sections, and introductions

▼ User interface and technical elements

▼ Tables and graphics

Convention Description and Use

Italic text Used for emphasis and book titles.

Bold text Identifies menu names, menu options, items you can click on the 
screen, and keyboard keys.

Courier font Identifies commands you enter at the command line, file names, 
folder names, and text that either appears on the screen or that you 
are required to type in.

Note: Provides extra information, tips, and hints.
2 Style Guide
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Related Documentation
The ESI Template contains all files necessary to create FrameMaker documents in the 
approved ESI format.

This document is a summary of commonly encountered style issues. It covers 
formatting, grammatical, and vocabulary elements most likely to be encountered at 
ESI.

For additional or more detailed information, see the following:

▼ <<Insert xrefs to any appropriate ESI style guide(s)>>

▼ The Chicago Manual of Style, 13th Edition, University of Chicago Press

▼ Bugs in Writing, Revised Edition, Lyn Dupré; Addison Wesley

▼ Merriam Webster’s Collegiate Dictionary, 10th Edition

▼ Microsoft Manual of Style for Technical Publications, 2nd Edition; Microsoft Press

▼ Microsoft Press Computer Dictionary, 3rd Edition; Microsoft Press
Style Guide 3
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CHAPTER 1

General Reference
Overview
This chapter contains information on the following topics.

Abbreviations and Acronyms
An abbreviation is a shortened form of a written word or phrase used in place of the 
whole. For example, temp., in., ht., and so on.

An acronym is a word formed from the initial letter(s) of each of the successive parts 
or major parts of a compound term. For example, ACE, SCSI, URL, and so on. 

General Guidelines

Use the following guidelines:

▼ Use abbreviations or acronyms only when you are certain that they can be under-
stood.

▼ At the first use of an abbreviation or acronym in a chapter, write out the term it 
represents and include the abbreviation or acronym in parentheses. For example, 
The table of contents (TOC) lists three levels of headings.
Before defining an Action/Classification Engine (ACE), verify that a similar ACE 
does not already exist. 

▼ After defining an abbreviation or acronym, use it consistently (do not use the 
spelled-out term again).

Section Page

Abbreviations and Acronyms 5

Capitalization 6

Hyphenation of Compound Words 7

Indexes 9

Lists 12

Numbers and Measurements 14

Personification 16

Punctuation 18

More Grammar Notes 20
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Note: Exception to the preceding rule: When a document will be converted to online and 
each section or chapter can be accessed independently by an end user, it is better to 
repeat the definition at the beginning of each major section.

Some abbreviations and acronyms are very familiar, and do not need to be spelled 
out. Some examples are:

Capitalization

Apply the following capitalization guidelines for abbreviations and acronyms.

▼ Use lowercase letters for abbreviations, unless the term is a proper noun.

▼ Use uppercase letters for acronyms.

Indefinite Articles

If an abbreviation or acronym starts with a vowel sound, use the indefinite article (a or 
an) appropriate for that sound.

Example: an ASCII text file
a HUD loan
a WNL blurb
a URL (pronounced as three letters)
a SCSI device; an SGI device

Latin Abbreviations

The meanings of Latin abbreviations are not clear to many readers. Use the English 
terms, if possible.

If you do use the Latin versions, follow the final period with a comma (see preceding 
table for example).

Capitalization
The following items listed are some of the areas for which capitalization decisions 
generally need to be made.

▼ ASCII ▼ HTML

▼ CD-ROM ▼ OS/2

▼ CPU ▼ RAM

▼ DOS ▼ ROM

▼ GIF ▼ SCSI

Latin English 

e.g., for example

i.e., that is, in other words

etc. and so forth, and so on
6 Style Guide
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▼ Initial caps in chapter titles?

▼ Initial caps in headings?

▼ Initial caps in table titles, figure captions?

▼ Index capitalization conventions

List commonly used words and their capitalization conventions in the appropriate 
letter section of Chapter 2, Terminology.

Sample Capitalization Section

This subsection is an example of what a company might include for capitalization 
rules.

▼ “Title caps” in chapter titles, headings, and figure and table titles when used

▼ Index: Capitalize only when the word itself is capitalized

▼ Nouns: Capitalize only proper nouns (that is, names of people, companies, or 
products). 

Example: Ellen Finch
Policy Accelerator 

Note: Do not capitalize technical terms or references to items that are not trademarked 
product names. 

Example: dynamic-link library (DLL)
software developer’s kit (SDK)
accelerator module 

Hyphenation of Compound Words
The hyphenation rules shown in this section cover most requirements for words 
commonly used in technical documents. 

General Hyphenation Rules for Modifiers

▼ Use a hyphen when it is needed to clarify the meaning or syntactical connection of 
the words forming the compound. 

Example: write-protected disk
user-defined function
computer-generated graphics

▼ If the hyphen does not aid readability, do not add it. For example:
wide area network

▼ Use a hyphen to join prepositional phrases used as adjectives. For example:
point-to-point protocol
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▼ Hyphenate compounds used as adjectives. Note when they do not get hyphenated.

Other prefixes to look for in this category:
all, cross, ex, half, high, low, quasi, self

▼ Never hyphenate the following types of compound modifiers:
❖ Adverbs ending in -ly: locally run organization, highly developed species, 

environmentally friendly product
❖ Compounds with proper names: South American countries, New Testament books
❖ Foreign phrases: grand prix racing, post mortem examination

Nouns and Verbs

▼ Do not hyphenate a noun formed from two nouns if the compound has only one 
primary accent. Note the use in the following table. 

Example: They scheduled a followup. (noun)
He was to follow up on the issue. (verb)
He forgot to make the followup call. (adjective)

▼ Hyphenate a single letter/noun combination. 

Example: B-tree
L-bracket

Prefixes

Most compound words involving prefixes are not hyphenated.

Do not hyphenate compound words with any of the prefixes below unless the root is a 
proper name, a number, a compound word, an abbreviation or an acronym. (See 
exceptions listed below this list.)

Exceptions to the preceding list are shown below.

The girl is humor impaired. She is a humor-impaired girl. (Sad.)

His whining was top notch. He was a top-notch whiner.

Noun Verb Adjective

followup follow up followup

setup set up setup

backup back up backup

ante de micro pre supra

anti extra mid pro trans

auto infra mini pseudo ultra

bi inter multi re un

bio intra non semi under

co macro over sub

counter meta post super
8 Style Guide
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▼ Use a hyphen to prevent doubling a vowel or tripling a consonant. For example:

See also the appropriate letter section for the term in question in Chapter 2.

Indexes

Size of Index

Typically, there should be one page of index entries for every 15 to 20 pages in the 
book, assuming that the index is two columns, the text in the index is 1 or 2 points 
smaller than body text, and run-in style.

Indexing Process Notes

It can be helpful to construct a list of terms before even starting the indexing (if you 
have the time).

It can also be helpful to mark up a hardcopy of the document with what you intend to 
index (if you have the time, although sometimes this can save you time in the long 
run).

Choice of Index Entries

Make logical choices based on content of the material and usefulness to the reader 
based on his level of experience and expertise with the product or related technology. 

Categories of entries:

▼ Product terminology (e.g., Foo class); very experienced product users use these 
more often

▼ Commonly used industry terminology

▼ Plain English terminology; inexperienced and less-technical users use these more 
often

Hyphenation Explanation

non-Volvo Root is a proper name

mid-thirties Root is a number

un-ionized Homonym is unionized

re-create Homonym is recreate

co-op Homonym is coop

non-Hungarian-speaking Root is compound word

non-ESI Root is abbreviation

anti-inflation de-escalate

co-editor pre-edit

co-worker pre-engineered
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What to index: names of functions, classes, elements, concepts, initial words that are 
English terms or industry standard terms that we do not use—for example, datagram, 
frames, packets, buffers. For reference types of things (like functions), index both the 
location of the function definition and the location of any other explanation of how 
the function is used. For example:

getList method
syntax, 48
using in an application, 109

Note: The preceding example is simplistic. If there are really only two references to getList, 
you might need only the entry getList 48,109. 
If there are several references, the main entry often has the page number(s) of the 
primary reference(s) or definition, such as

getList method, 48
code examples, 67, 115
syntax, 66
using in an application, 109

Main and Secondary Entries

▼ Main entries are generally plural nouns. Exceptions to this include
❖ Proper nouns, such as UNIX
❖ Collectives, such as e-mail
❖ Items which are always singular in the context you are writing about, such as 

mainframe
In general, stick to nouns for the first level (e.g., ACE, packets, operating system) 
and list more specific nouns or verbs (“-ing” form) at the second level. For 
example:
channels

configuring, 28
data in, 15
subcode for, 80

pins
connecting, 22
descriptions, 20
diagram of pinouts, 165

▼ Second level entries have two basic variations: subcategory of primary entry (e.g., 
packets:headers), or grammatical phrase including primary entry (e.g., pack-
ets:transmitting; packets:determining type of). [Note: We do not always include 
the final connector words like “of” in these cases; hence, packets:determining 
type.]

Levels of Entries

A two-level index is easy to read and usually covers enough information for general 
use. Specify up to three levels of entry if you absolutely must. Our templates do not 
support more than three levels and additional levels are harder to create and 
maintain.

▼ If there are more than four or five page numbers associated with a primary entry, 
split it into subentries.
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▼ If there are many subentries for one main entry with single pages, it is sometimes 
easier for the reader if you can find a way to combine subentries. This is a judge-
ment thing.

See and See Also Cross-references

If you have two or more synonyms for the same concept, put all of your page number 
entries under your document’s preferred terminology choice and use see entries for 
the synonyms. For example, instead of having entries both under packets and under 
datagrams, pick the preferred term for the actual page numbers and do a see for the 
other. Hence, it might be

packets, 7, 14, 21
datagrams, see packets (an industry standard term that you are not using)
information in a network, see packets (an English phrase for the concept)

When a term has been indexed as a subentry under a different primary entry, also use 
see.

Use see also when there is at least one page number for the current entry. Use only see 
when the current entry is solely a cross-reference. For example:

cats
eating habits, see finicky
sleeping, see televisions

dogs
see also canines, mammals
eating habits, 3 
sleeping, 27

Here are some see and see also guidelines:

▼ See and see also entries should use the exact phrasing of the reference; e.g., see also 
packets, determining type of

▼ The client should specify their preferences for these entries, including
❖ The use of capitalization and italics (see vs. see vs. See vs. See). In general, use 

italic and lower case. 
❖ Where these entries appear in the index. In general, place the see also entries at 

the beginning of the subentry list so the reader notices them right away. For see 
entries, try to make them part of the main entry:
Use this format: dogs, see canines

Not this format: dogs,
see canines

Formatting

This section provides formatting guidelines for those who are using tools other than 
our standard templates, and to ensure that our standard templates meets these 
formatting guidelines.

Capitalization Conventions

Do not capitalize the first letter of an index entry unless the term is normally 
capitalized, for example, if it is a proper noun. However, some clients prefer entries to 
use initial caps.
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Page Reference Formats

Rules for page numbers in index entries:

▼ Use the same text style as the entry itself (do not use bold or italic)

▼ Separate lists of page numbers with commas

▼ Indicate a range of page numbers with an en dash (–) (we do not usually use page 
ranges for our ESI documents)

▼ If the page numbers in the book use the chapter-page format, such as 2-1, 2-2, etc., 
us the word “to” instead of the en dash for ranges.

Lists
Use lists to organize information so readers can grasp concepts and relationships 
quickly and perform tasks easily.

Always try to introduce lists with a complete sentence.

Capitalization

Capitalize the first letter of each item in a list. 

Example: Dogs have the following attributes:
• Legs
• Noses
• Endless energy

Bulleted Lists

Use bulleted lists to

▼ Itemize parallel elements in a sentence or paragraph

▼ Introduce, summarize, or provide an overview of information

If you use a bulleted list for summary or emphasis purposes, make sure the order in 
the list echoes the order in which the topics appear in the document.

Numbered Lists

Use numbered lists to indicate a hierarchy, order, or procedure. Follow these 
guidelines:

▼ Start each list with the number 1. 

▼ For tasks a user is to perform, use a procedural list for added clarity.
❖ Use the numbered line to list the task, preferably starting the sentence with a 

verb. For example:
1. Create the main directory.

❖ Each step should describe only one action, unless the actions are closely related 
(for example, 2. Make a selection and press Return).

❖ The results of a step should not be formatted as a step, rather as a continuation. 
For example:
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Copyright © 1990-2003 Expert Support Inc.  All rights reserved.



1. Create the main directory.
The directory structure appears as shown in the following figure.

Use this continuation area to provide more information about the task, as well.

Page Breaks in Lists

Apply the following guidelines to make the list more readable.

▼ Do not separate a list from the clause that introduces it.

▼ If you must split a list, make sure that the entire contents of the first and last items 
in the list appear on their respective pages.

▼ Always make sure that at least two items in the list appear on a given page (so 
avoid single bullet or number orphans).

Parallelism in Lists

Make all the items in the list grammatically parallel (same tense and sentence 
structure). 

Example of nonparallel list:
• Supports many commands
• You can download subroutines
• Automated backup

Example of parallel list:
• Supports many commands
• Allows downloading of subroutines
• Automates backups

Punctuation in Lists

Apply the following guidelines for punctuating lists.

Punctuating the List’s Introduction

▼ End the introduction to a list with a colon if it contains the phrase “as follows” or 
“the following.” Use either a colon or period after an introductory sentence. 

Example: Use one of the following options to pacify your boss:
1. Say, “Wow, that’s brilliant.”
2. Offer her cookies.

Example: Your next task is to write the book.
1. Get paper.
2. Get pen.

▼ If the introduction is a sentence fragment, or if the list is the object to a grammati-
cal part of the introductory phrase, do not punctuate the introduction.

Example: This chapter explains how to
• Make a rubber chicken
• Annoy your neighbors
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Punctuating List Items

▼ If the items in a list are complete sentences, end each with a period. 

Example: Do one of the following:
• Press F7 to save the file to a location you specify.
• Select the Kill option to bypass the Save function.

▼ If the items are not complete sentences, do not use periods. See rubber chicken 
example above.

▼ Apply punctuation consistently for all items within a list, that is, if only one item 
needs a period, apply periods to all items. 

▼ For consistency, revise the list so that the entries have parallel construction; then 
you are not violating these punctuation rules. 

Numbers and Measurements
Rules for numbers are complex. Use these guidelines as a starting point.

Spelling Out Numbers

Spell out numbers in the following cases:

▼ Integers below 10. For example, one, two, three, etc.

▼ Numbers that begin a sentence. For example:
Thirty-one years ago, the world was a dark place.

▼ Ordinals. For example:
the sixth step
the third option

▼ Two numbers in succession. Spell out the first one. For example:
Fifty 9-inch nails

▼ Nondecimal fractions. For example:
One-half of the attendees laughed.

Using Numerals

Use numerals in the following cases:

▼ Integers above nine. For example, 10, 11, 69, etc.

▼ Round numbers greater than 999,999 are written as a combination. For example: 
1 million
1.7 million
1,732,486

▼ All items in a series when at least one item is over nine. For example:
She had eaten 5 eclairs, 15 napoleons, and 2 bananas.

▼ Technical units and units of measure. For example:
12 MB
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▼ Specific references to step, section, or page numbers. 

▼ Decimals. Use 0 before the decimal. For example:
0.95

Punctuating Numbers

The rules for punctuating numbers are similar to that of text. The differences are 
covered here.

▼ When referring in text to numerals containing four or more digits, use a comma 
three digits from the right. For example:
2,000

200,000

This rule does not apply for computer chip numbers (68040).

▼ Hyphenate adjectival forms before nouns. For example:
3.5-inch diskette
100-pin package

100-MB disk (non-adjectival, so no hyphen: 100 MB of disk space)

▼ For number ranges, use the terms to or through in text; use an en dash in tables and 
figures. 

Measurement Designations

Rules for measurements: 

▼ Spell out first occurrence of an abbreviation; for example:
16 megabytes (MB)

▼ Avoid K and M; too general

▼ Use a space between number and abbreviation:
16 MB (note that 16M is an exception)

Preferred abbreviations: 

▼ MB (megabytes)

▼ MB/sec.

▼ Mbit (megabits)

▼ Mbps (megabits per second)

▼ KB (kilobytes)

▼ GB (gigabytes)

▼ TB (terabytes)

▼ PB (petabytes)

▼ MIPS (million instructions per second)

Text Tables/Figures

You will need 40 to 60 MB to run this software. 40–60 MB

Do Steps 1 through 4 to add your dog to the database. Steps 1–4
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▼ MHz (megahertz)

Temperatures are formatted with the following three parts:

▼ Temperature as a number

▼ No space followed by the degree mark °

▼ Thin space (esc space t in Frame) followed by either C or F, or no space if thin 
space is not an option in the program
For example: 52°F

Operators

The rules for operators are similar to the rules for numbers.

▼ Spell out operators in sentences. For example:
is greater than, is equal to, subtracted from

▼ Use the Symbol font operators in equations.

Personification
Use verbs that describe machine processes in nonhuman terms.

This section contains lists of human-oriented terms and some possible inanimate 
replacements. 

Human Inanimate

Sight and Perception

check to see consider perceive verify

look discern recognize view

notice distinguish regard

observe examine search, search for

see locate seek

watch/watch for monitor validate

Cognition

to be aware of accept manipulate

believe argue reason

catch choose recognize

consider compare regard

decide confirm reject

deliberate contrast retain

intend decide select

judge design store
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know determine weigh

realize equate

remember evaluate

think examine

understand interpret

Communication

ask acknowledge inform report

request announce instruct respond

say cite introduce route

tell communicate offer show

confirm contend point to signal

deny print state

display prompt specify

indicate reply

Want/Need

desire (to be) compelled require

expect lack wait for

favor must

intend need

prefer

want

wish

Human Inanimate
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Punctuation
This section describes the use of punctuation to promote ease of reading and to 
prevent misreading.

Apostrophes

An apostrophe (’) indicates either a possessive noun or a contraction. The following 
list shows some places not to use apostrophes.

▼ Do not use contractions in technical publications. (Compare to: Don’t use contrac-
tions—)

▼ Plurals of acronyms or abbreviations do not use an apostrophe. For example:
LANs, URLs, DVDs, TVs

▼ Plurals of nouns do not use an apostrophe unless the plural noun is also posses-
sive. For example (this is tricky, now; pay attention):

Colons

Colons indicate that the information after the colon deserves special attention.

See also “Punctuation in Lists” on page 13. 

▼ Do not use a colon to separate a verb from its object. For example:

▼ Do not use a colon to separate a preposition from a phrase or to break up an infini-
tive when introducing a list. For example:

▼ Put colons outside of quotation marks unless they are part of the quoted material.
See also “Quotation Marks” on page 20.

Commas

These are some of the more commonly used conventions for the use of commas. 

▼ Use serial commas. 
They had ice cream, chocolate, and lasagna.

▼ Put commas inside of quotation marks.
See “Quotation Marks” on page 20 for additional info.

Incorrect: We have three customer’s named Joe, Sam, and Margie.

Correct: The customers were irate; one customer’s site had vanished; the other 
customers’ sites could vanish at any moment.

Incorrect: The cats that must be neutered are: Hojo and Clam.

Correct: The cats that must be neutered are Hojo and Clam.

Incorrect: Create scripts for:
• Users
• Groups

Correct: Create scripts for
• Users
• Groups
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▼ Use commas to set off nonrestrictive clauses, using which. You can remove a nonre-
strictive clause from the sentence without changing the meaning. For example:

Example: The aardvark, which I had named Albert, walked over to me awkwardly.

▼ Do not use commas to set off restrictive clauses; use that (and not which). Remov-
ing a restrictive clause from a clause changes the meaning of the sentence. For 
example:

Example: The aardvark that is in my kitchen is named Al. (The one in the living room has 
not introduced himself yet.)

▼ Do not use a comma before a conjunctive adverb joining two parts of a sentence; 
rather, use a semicolon. The following table lists some commonly used conjunctive 
adverbs.

▼ For example:

Dashes

Em Dash/En Dash

Use an em dash (—) to set off explanatory or digressive elements. For example—if 
you need an example—this sentence uses em dashes correctly. Do not use spaces 
around the dash. 

Use an en dash (–) to set off ranges (do not use spaces around the dash), and as a 
minus sign (if not using the equation editor).

To create an em dash or an en dash

In Word, you can also insert a variety of dashes through the Insert > Symbol menu. 

Hyphenation

For information on hyphenation, see “Hyphenation of Compound Words” on page 7 
and the appropriate letter section for the term in question in Chapter 2, Terminology.

accordingly hence then

also however therefore

besides moreover thus

consequently nevertheless too

further occasionally

furthermore otherwise

Incorrect: Choose the X menu, then press Return.

Correct: Choose the X menu; then press Return.

Microsoft Word (Windows) FrameMaker (Windows)

em dash ALT+CTL+numeric - CTL+q+SHIFT+q

en dash CTL+numeric - CTL+q+SHIFT+p
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Quotation Marks

The term quotation marks refers to “ ”. These are sometimes called “double quotation 
marks.”

▼ Use quotation marks with chapter titles, sections, and headings referenced in text.

Example: See “Wallabies and Wombats” for a detailed description.

▼ Do not use for titles of documents; instead, italicize. 

Example: See The Chicago Manual of Style.

▼ Place colons and semicolons outside of quotation marks unless they are part of the 
quoted material.

Example: The following agenda items came from Joe’s comment to “get organized”:

▼ Place commas and periods inside of quotation marks. For example:

Example: “This,” “is”: “an example.”

However, if you are putting commands that the user needs to type in quotation 
marks, and a comma or period is necessary immediately after the command to be 
entered, do not place it within the quotation marks; the placement could confuse the 
reader and lead them to believe the punctuation is part of the command.

Note: Single quotation marks are used ONLY for quotations within quotations.

Example: She said, “No, I didn’t say ‘I owe you money.’ I said, ‘I own a monkey.’ Maybe you 
need a Sprint PCS phone.”

Semicolons

▼ Semicolons join two closely related ideas. Both parts of the sentence on either side 
of the semicolon must be complete sentences.

▼ Use semicolons in a complex list within a sentence that also includes commas. 

Example: He has translucent, white skin; tangled, dyed black hair; and piercing brown 
eyes.

More Grammar Notes
This section addresses common grammar questions.

That vs. Which

▼ Which sets off nonrestrictive clauses, that is, clauses you can remove from the sen-
tence without changing the meaning. 

Example: The aardvark, which I had named Albert, walked over to me awkwardly.

▼ That is used to set off restrictive clauses, that is, clauses you cannot remove from 
the sentence without change the meaning. 

Example: The aardvark that is in my kitchen is named Al.
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As a general rule of thumb, if the term that would require a comma to precede it, use 
which.

If vs. Whether

Use if when there is a corresponding then part of the sentence (even when the then is 
only implied). Use whether when there is no corresponding then. (Note that whether or 
not is often redundant; use this phrase only to mean regardless of whether.)

Example: He wanted to know whether I was Martian, because if I was, [then] he wanted a 
photograph. Whether or not I was Martian, he thought that I had an attractive 
protocol.

Since vs. Because

Since refers to time, whereas because does not. For example:

Like vs. Such As

Do not use like in place of such as. Like means resembling. For example:

Example: She walks like a duck (that is, she walks as a duck waddles).
Large mammals, such as elephants, need lots of space.

Active vs. Passive Voice

Use active voice whenever possible. To change passive to active, ask who performed 
the action.

Passive

Example: When an application bar is clicked... (Who clicks it?) 
Additional classification rules will be added. (By whom?) 
By holding down Ctrl-C, the system can be rebooted. (Who holds down the key? 
and/or Who reboots the system?)
By setting the XYZ register, the ABC signal is sent. (Who sets the register? Who 
sends the signal—and where?)
The checksum is transmitted to the next device. (Who transmits it?)

Active

Example: Click the application bar to...
You can add additional classification rules...
By holding down Ctrl-C, you can reboot the system. (Or, better: To reboot the 
system, hold down Ctrl-C.)
When the firmware sets the XYZ register, the NM666 sends the ABC signal to the 
microprocessor.
The fribulator transmits the checksum to the next device.

Incorrect: I went to the store since I didn’t have any kumquats.

Correct: I went to the store because I didn’t have any kumquats.

Correct: I have been eating jellied eels since 1971.
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I vs. We

Use I to refer to your own actions or beliefs.

Use we to refer to ESI, to a client, or to something involving the reader (except as noted 
below).

Use you to refer to an action the reader should take, or to refer to the reader directly.

Note: Clients often prefer to avoid personal pronouns. In this case, substitute more generic 
or neutral terms. For example, use the company name instead of “we” and “the user” 
or “customers” instead of “you.” For consistency, avoid first person “I” as there is no 
generic substitute. 

Always be consistent and stick to one format rather than switching between the use 
of personal pronouns and neutral terms. For example, if you start out by referring to 
the reader as “you,” do not switch to “the user” a few paragraphs later. 
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CHAPTER 2

Terminology
Overview
This chapter lists commonly used terms, some of which are often incorrectly used or 
spelled. The items in this chapter are provided as a starting point. Use this chapter to 
add other client-specific entries, as needed.

Words and Phrases To Avoid
These terms are often used by clients; sometimes you will have no choice but to use 
the offending language. However, this section also lists alternatives for conveying the 
same information.

Section Page

Words and Phrases To Avoid 23

Localization 24

Alphabetical Listing of Terms 26

To Avoid Options

iconize
iconify

Make into an icon

incentivize motivate; provide incentive

to mouse anything Use the x mouse button to ...

genericize
genericization

Make generic

hypothesize Form a hypothesis

computerize Make computer based

impacted, as in “has an effect on”

▼ error bottlenecking

▼ bottleneckable error

▼ error bottleneckization

▼ Handle errors in a single location

▼ Errors that can be handled in a single 
location in the code

▼ ...get a valium...

upgrading (as a noun) update

signedness (meaning what??)
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As technology changes, some terms that were considered to be non-English gradually 
become accepted. The following table lists some that are on the edge of acceptance.

Verbizing Nouns

When you are tempted to use a word ending in “-ize,” the odds are good that you are 
creating a word where an equally effective word already exists. Some examples are 
given in the preceding tables. (And yes, the heading of this section is intended to be a 
joke.)

Latin Terms

Avoid Latin terms, whether abbreviations or whole words.

See per and via in the preceding table and “Latin Abbreviations” on page 6. <<Note: 
“per” is not in the previous table. Add examples for this.>>

Localization
We hope that our product will become much in demand and be translated into a 
variety of languages. In all languages, including English, we want our product to be 
easily and quickly understood.

sendable

to message

merchantability

utilize use

via by
using
through

Borderline Options

encodings 
(awkward, but it is becoming very common 
as in “character encodings”)

portability

thunked

overridable Can be overridden

You can override this

readability

deselect

double-clicked 
(as in the button was double-clicked)

To Avoid Options
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Ambiguous Terms

For these reasons (and others), it is important to use terminology that is consistent and 
unambiguous.

Here are some commonly used overloaded or ambiguous terms and their alternatives:

Ambiguous or 
Overloaded Term

Meanings Correct Example Incorrect Example

once a single time Do this step only once.

after Do this step after you have booted 
the system

Do this step once you have 
booted the system.

kind sympathetic You are kind and generous.

variety/category There are three varieties of 
widgets.

There are three categories of 
widgets.

There are three kinds of 
widgets.

in a way or similar to 
(kind of)

This is similar to rebooting. This is kind of like rebooting.

type press the keyboard Enter your name and press 
Return.

variety/category There are three varieties of 
widgets.
There are three categories of 
widgets.

There are three types of 
widgets.

programming language 
element

There are two variable types: 
Integer and Real.

may has the ability to The command can use any 
existing files.

The command may use any 
existing files.

has permission to Yes, you may leave the table now. Yes, you can leave the table 
now.

might or perhaps The command might use any 
existing files [in the following 
situations].

The command may use any 
existing files.

right correct Select the correct header. Select the right header.

immediate (right away, 
right after)

The next packet arrives 
immediately after the header.
The next packet arrives 
immediately.

The next packet arrives right 
after the header.
The next packet arrives right 
away.

opposite of left Select the left or the right
channel.

Read the dial on the right. Read the right dial.
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Colloquial Terms and Phrases

Phrases that Americans use for commonly recognized American activities, culture, 
and so on, especially metaphorical meanings, are often difficult to translate. Avoid 
phrases similar to the following:

Don’t get left behind the curve.

State of the art

If you choose to use colloquial expressions, such as the following, ensure that they are 
clearly explained in the glossary for future translation:

Make your application scream.

Then, in the Glossary:
In the context of “make your applications scream,” meaning to make your applications 
operate extremely fast. Use only in marketing literature, not in technical documents.

Alphabetical Listing of Terms

Conventions Used in This Section

The following conventions are used in this section:

▼ Capitalization is significant

▼ The term <word> denotes a variable. Entries in this form are used to indicate the 
absence or presence of a hyphen, or specific ways of handling certain terms. For 
example:

Example: <word>like

This indicates that a compound word containing the “like” suffix is not 
hyphenated, as in childlike, Windowslike, and so on.
This notation can also denote capitalization (<Word> vs. <word>), which may be 
useful for certain client-specific applications.

Terms

The terms listed below show standard formatting, hyphenation (or lack of 
hyphenation), capitalization, and plural formats. Exceptions to these rules are shown 
in “Hyphenation of Compound Words” and “Capitalization” in , Chapter 1, “General 
Reference.”
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A anti<word>

auto<word>

B bitwise

<word>-based

Boolean

C callback (as in callback function)

cannot

CD-ROM (plural: CD-ROMs)

co<word>

co-edit

<word>-compatible

cross-<word>

custom-<word>

D database

datatype

dereferencing

<word>-driven

E <word>-end

endian

Ethernet

extra<word>

F far pointer

fax

fiber-optic network

Fibre Channel

field name (2 words)

filename (1 word)

I identifier
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inter<word>

initialize

initialization

Internet

intra<word>

J JPEG

L laptop

<word>like

M menu bar 

modem

multibyte

multiclient

multi<word>

<word>most

N near pointer

nonpreemptive

non<word>

O offline (but many clients prefer off-line)

online (but many clients prefer on-line)

P post<word>

postfilter

pre<word>

prefilter

R re<word>

re-entrant

S scalar
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single-byte

single-client

single-<word>

status bar

sub<word>

subsystem

T tool bar

W World Wide Web (WWW)
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CHAPTER 3

Client-Specific Conventions 
Overview
This chapter is provided as a template for other project-specific needs that are not 
covered in the first two chapters.

Some topics to consider include

▼ Copyright notices

▼ Trademark notices

▼ Third-party trademark notices

▼ Notation for trademarks and copyrights

▼ License agreements

▼ Confidential notation

▼ List of trademarks and registered trademarks

▼ Logo usage

▼ Standard illustrations

Copyrights and Trademarks
Most documentation intended for external use (that is, for use outside of the company 
that produced the document) requires a copyright and trademark notice. Each client 
should have guidelines for the placement of this block, and for what items are 
included in it. Information frequently listed in this block includes the following:

▼ A list of trademarked names and branded items claimed by the client and by its 
partners

▼ Restrictions on the use of the product or materials described in the document

▼ Restrictions on the copying and distribution of the document

▼ A legal statement of liability limitation on claims made in the document

In general, this notice is placed at the front of a document after the title, or at the end 
of the document on or before the last page. 

Section Page

Copyrights and Trademarks 31
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Here is a sample copyright and trademark notice from Sun Microsystems:

Copyright 2003 Sun Microsystems, Inc. All rights reserved.
Sun, Sun Microsystems, the Sun logo, iForce, Solaris, VIS, Netra, Sun Fire, Java, 
JavaScript, and Sun StorEdge are trademarks or registered trademarks of Sun 
Microsystems, Inc. in the U.S. and other countries. 

All SPARC trademarks are used under license and are trademarks or registered trademarks 
of SPARC International, Inc. in the U.S. and other countries. Products bearing SPARC 
trademarks are based upon an architecture developed by Sun Microsystems, Inc.
UNIX is a registered trademark in the U.S. and other countries, exclusively licensed through 
X/Open Company, Ltd.

For most Sun documents, a list of trademarks such as that shown above is sufficient. 
For some documents, they add additional notices, like these:

This product or document is protected by copyright and distributed under licenses restricting 
its use, copying, distribution, and decompilation. No part of this product or document may be 
reproduced in any form by any means without prior written authorization of Sun and its 
licensors, if any. Third-party software, including font technology, is copyrighted and licensed 
from Sun suppliers.

RESTRICTED RIGHTS: Use, duplication, or disclosure by the U.S. Government is subject 
to restrictions of FAR 52.227-14(g)(2)(6/87) and FAR 52.227-19(6/87), or DFAR 252.227-
7015(b)(6/95) and DFAR 227.7202-3(a).
DOCUMENTATION IS PROVIDED “AS IS” AND ALL EXPRESS OR IMPLIED 
CONDITIONS, REPRESENTATIONS AND WARRANTIES, INCLUDING ANY IMPLIED 
WARRANTY OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR 
NON-INFRINGEMENT, ARE DISCLAIMED, EXCEPT TO THE EXTENT THAT SUCH 
DISCLAIMERS ARE HELD TO BE LEGALLY INVALID.

Third-Party Trademarks

Each client has their own rules.

▼ For most companies, only the trademarks and brands they own are listed in their 
notice. 

▼ Some include trademarks and brands owned by their partners as well. Generally 
these are partners with whom they have agreements stating that they will 
acknowledge their products. 

▼ Some documents simply make a general statement that all trademarks mentioned 
in the document are the property of their respective owners and do not take the 
time to itemize them. 

Notation for Trademarks and Brands

Some basic varieties of marks include the following:

▼ Trademarks are marked with the ™ symbol . This mark is generally applied to 
products. 

▼ Registered trademarks are designated by the ® symbol. This also designated prod-
ucts, usually with a wider legal registration for use in multiple locales or different 
markets. 
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▼ Service marks are designated by the SM symbol. This mark is generally used for ser-
vices or programs.

What is actually marked in a document varies from client to client. 

▼ Some clients do not include these symbols in their documents. 

▼ Others mark selectively, such as the first occurrence of the trademark name in the 
document, or prominent usage. 

▼ Some clients mark every instance of the trademark in a document. 

Rules for Usage—Trademarks as Adjectives

All trademarked items are considered adjectives, and as such, should always be 
followed by an appropriate noun. Not all clients are concerned with this rule, but it is 
a factor to consider when planning a document. Here are some examples:

Example:

Rules for Usage—Abbreviations

In general, it is acceptable to abbreviate a trademark after it is written out in the first 
occurrence in a document. 

Example: The Java Dynamic Management Kit (JDMK) is installed on that system. To start the 
JDMK, click the Start button in the dialog box. 

Some trademarks have specific rules and cannot be abbreviated. Contact your 
company’s legal or trademark department for specific information.

Incorrect:  Java is used by programmers around the world

Correct: The Java programming language is used by programmers around the 
world.

Incorrect: She keeps her shampoo in a Ziploc when she travels.

Correct: She keeps her shampoo in a Ziploc bag when she travels.
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CHAPTER 4

Formatting and Context 
Guidelines
Typically, the FrameMaker or Word template used by technical writers addresses 
many of the issues discussed in this chapter. However, not everything can be handled 
automatically, and for those working on documents or in departments where there is 
no standard template available, it is helpful to have this information available. This 
chapter provides some general guidelines and rules for formatting.

ESI FrameMaker Template
The ESI FrameMaker Template contains all files necessary to create FrameMaker 
documents in the approved ESI format.

This template includes a summary of commonly encountered style issues. It provides 
examples for the topics descussed in this chapter, such as how to format lists, 
headings, paragraphs, and so on.

Note: The material in this chapter can be applied to any documents whether or not 
FrameMaker is used.

Book Construction
A product manual consists of the following (see the ESI FrameMaker template for 
details):

▼ Title page

▼ Copyright page on back of title page (pages unnumbered)

▼ Table of Contents (numbered in lowercase Roman numerals starting at i)

Section Page

ESI FrameMaker Template 35

Book Construction 35

Cross References 36

Chapters, Sections, and Introductions 37

User Interface and Technical Elements 37

Tables 38

Graphics 40
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▼ About this Book (continue numbering in Roman numerals)

▼ Chapter files (numbered in Arabic numbers starting at 1)

▼ Appendixes optional (continue numbering)

▼ Index optional (continue numbering)

▼ Back page with license agreement (license agreement not required for hardware-
only documents)

Cross References
When cross referencing another document, section, or element, use the following 
formats.

Element Sample format

Document titles ESI Programmer’s Reference 

Chapters and appendixes Appendix A, “ESI Template—Sample Appendix.” 
Chapter 5, “ESI API” on page 25
Appendix A, “ESI Template—Sample Appendix,”
Chapter 5, “ESI API.” 

Lower-level headings (sections 
within chapters)

“Your First ESI Application”
“Your First ESI Application” on page 21
“Your First ESI Application‚”
“Your First ESI Application.”

Heading without quotes; use 
rarely, primarily for text that will be 
converted only to HTML, not 
hardcopy, and the quotation marks 
would look out of place.

Your First ESI Application

Page ...on page 21

Step ...in Step 3

Tables ...the following table.... 
...the preceding table...
...the table on page 21...

Figures ...the following figure.... 
...the preceding figure...
...the figure on page 21...
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Chapters, Sections, and Introductions
Generally, every logical chunk of a document should be introduced so the reader 
knows what is coming up, why it is of interest, and what the context is. Examples are 
shown in the following table. 

User Interface and Technical Elements
To ensure consistency among documents, use the following type styles and formats 
for user interface and technical elements in text.

Chunk Examples of introductory material

Chapter This chapter describes _________, explains how to _______, 
and lists _________. It contains the following topics:

▼ “First Section,” which describes _______

▼ “Second Section,” which explains _______

Tables and figures The following table lists_____

The following figure shows _____

Headings lower than 
chapters

[at least one line of text before next lower header level, table, 
figure, etc.]

Subheadings [at least 2 of a given level of heading under a single higher 
level, otherwise why have a subheading? for example:

HeadingLevel1
HeadingLevel2
HeadingLevel2

HeadingLevel1

Element Format

Filenames When using a specific name, capitalize as on the system; for example, 
foo.dll.
When referring to files in generalized terms, use consistent English 
terms if possible. For example:

Good: Move the library files to....
Good: Move the DLL files to....
Not as good: Move the .dll files to... 
Even worse: Move the *.dll files to...

If you must be specific, perhaps an example would be better:
mv *.dll foo\....

Keyboard keys Capitalize the key name and press it. For example:
Press Enter. 

If the key name is an abbreviation, use all uppercase, as in ESC, ALT, 
CTRL, or DEL. We do not really have a convention for key sequences. 
For simultaneous keys, we could use:

Press CTRL+ALT+DEL
For sequential keys, we could use:

Press CTRL, W, P
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Tables
This section describes several formatting standards for tables.

Menus, submenus, 
and menu 
commands

Examples:
Select Open from the File menu. [or]
From the File menu, select Open.
There are several commands on the File menu. If the Open 
command is unavailable, select New.
The File menu includes several submenus, including Import and 
Utilities. 
From the File menu select Import > Formats.

Do not include ellipses on submenu names (e.g., do not write 
Import...).
<<Note: We need a standard way of designating multiply nested menu 
commands, such as Menu:Submenu:Subsubmenu:Command? MS 
style guide does not address this.>> 

Typing Enter a command or value on a command line, not type it.

But type it into a text box in a dialog box. 

Buttons Click a button (not press it).
For example:

Click Save.
(Expand to Click the Save button only when needed to clarify an 
ambiguous situation.)

Dialog boxes and 
components

A dialog box usually has a title; hence: “the Marker dialog box 
appears.”
Dialog boxes can contain the following elements:

▼ Text boxes (in which you type text)

▼ Drop-down lists (from which you select a value)

▼ Option buttons (usually round; you can select only one and the 
others then automatically deselect)

▼ Check boxes (which you select or clear)

▼ Scroll bars

C-language 
elements and 
examples

Use monoproportional font, such as Courier.

Directories Use monoproportional font, such as Courier. Use backslash (\) to 
designate levels of directories (e.g., include\nbapi.h). 

Element Format
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Alignment of Tables

Left-align tables under the level of text with which they are associated. For example: 

For lists:

▼ Here is a bullet

Table Titles

Use titles only when needed to make the table clearer.

Table Cell Parallelism

Entries in columns of table cells (and across column headings) generally should use 
parallel grammatical construction. For example:

Good:  

Bad:  

Table 1. Table Under Standard Body Text

Table 2. Table Under A Bullet

Requirement Description Description 
(OK alternate)

Windows NT Install the latest version available from Microsoft. Latest version

Disk space Ensure that at least 28 megabytes is available on 
your system disk.

28 megabytes

Memory Use the xxx command to verify that you have at least 
99 megabytes of memory available.

99 megabytes

Requirement Description

Use Microsoft Windows NT release 
27 with distributor pack 3.

Plenty of Disk space Ensure that at least 28 megabytes is available on 
your system disk.

Memory 99 megabytes
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Unlined Tables

Use unlined tables generally only to format a list into columns. For example:

Example: Some commonly used conjunctive adverbs are listed below.

Graphics 
To insert a graphic:

1. Create an Anchor paragraph. 

2. Insert an anchored frame in that blank Anchor paragraph line, using the setting 
Below Current Line and a width of 5.25 inches for graphics that fit within the body 
text column. 

3. Place the graphic within the anchored frame 0.0 inches from the top and 0.0 inches 
from the left. 
You can do this after creating the complete graphic by selecting all inside the 
frame, grouping them, then adjusting the Object Properties of the grouped object.

4. Adjust the bottom of the anchored frame so it is approximately 0.125 inches from 
the bottom of the graphic.

5. Left-align figures under the level of text with which they are associated, as with 
tables. (Select all in frame, group, and use Object Properties to set:
❖ Offset from Left to 0 for standard body text, 0.2 for beneath bullets or numbers, 

etc.)
❖ Offset from Top to 0

6. If you want a caption, use Figure tags after the figure.

Callouts

Callouts in a graphic have two components:

▼ Text, which should use the Callout character tag. Apply Bold as needed.

▼ Line indicating which element in the graphic that the callout refers to (optional). 
The line, if used, should:
❖ Have 1-pt. line width (narrower looks nicer in hardcopy but vanishes online)

accordingly hence then

also however therefore

besides moreover thus

consequently nevertheless too

further occasionally

furthermore otherwise

Sample Graphic Under Bullet2
Note it is aligned under the Bullet2
text; text and graphic elements are all
part of the graphic so leftmost part
is left-aligned.
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❖ Use the Highlight color 
❖ Approach side of callout on a straight horizontal line
❖ Use only right angles if possible (except brackets for groups of things, where a 

45-degree angle is OK)

Example:

Screen Captures

▼ When using SnagIt (downloadable application) to do screen captures, save the files 
as TIF files using LZW RGB compression. This minimizes the file sizes.

▼ You can do a quick and dirty screen capture without SnagIt by pressing the 
PrntScn button and then pasting into a Word or a FrameMaker document. How-
ever:
❖ Whichever tool you use for screen captures, try to make the screen you are 

capturing the actual size that you want it before you capture it, so you do not 
have to scale it at all in FrameMaker.

❖ Always import these files by reference; do not include them in the file.

Square

Circle Several items
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Index
A
abbreviations

capitalization of 6
general rules 5
Latin, use of 6
plural 18
trademarks 33
use of indefinite articles with 6

acronyms
capitalization of 6
general rules 5
plural 18
use of indefinite articles with 6

active vs. passive voice, use of 21
adjectives

hyphenation 8
alphabetical listing of terms 26
ambiguous terms 25
anchor tag, using 40
apostrophes 18
appendix files 35

B
because vs. since, use of 21
book construction 35
brands, notation 32
bulleted lists

capitalization 12
use of 12
with tables following 39

button references 38

C
C language references 38
callouts in graphics 40
capitalization, general rules 6
chapters

book construction 35
cross-reference formats 36
introductions 37

code formatting 38
colloquial language 26
colons, use of 18
commas, use of 18

compound words, hyphenation 7
contractions 18
conventions, typographical 2
copyright

book construction 35
sample block 32

Courier font, use of 38
cross-references

formats 36
in indexes 11

D
dashes, use of 19
dialog box references 38
directory-name formatting 38
document formats 35

E
e.g., use of 6
em dash

correct use 19
creating 19

Emphasis, use of 26
en dash

correct use 19
creating 19

enter 25
etc., use of 6

F
figures, see graphics
filename formats 37
files in a book 35
formatting guidelines 35

G
grammar notes 20
grammatical parallelism in lists 13
graphics

alignment 40
callouts 40
captions 40
cross-reference formats 36
formatting 40
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inserting 40
introductions 37
screen captures 41
spacing 40

H
headings, cross-reference formats 36
hyphenation

compound words 7
modifiers 7
nouns and verbs 8
numbers 15

I
I vs. we, use of 22
i.e., use of 6
if vs. whether, use of 21
illustrations, see graphics
indexes

book construction 35
capitalization 7, 11
choice of entries 9
conventions used for 9
formatting 11
levels 10
main vs. secondary entries 10
page reference formats 12
see and see also 11
size 9

introductions 37

K
key point, explanation of 2
keyboard key formats 37
kilobytes abbreviation 15

L
Latin

abbreviations, use of 6
terminology 24

license agreement 35
like vs. such as, use of 21
lists

bulleted 12
capitalization 12
general use 12
numbered 12
page breaks in 13
parallel structure 13
procedural 12
punctuation in 13

localization 24

M
may vs. might or can 25
measurements

basic rules 14
designations 15

megabytes abbreviation 15
menus and menu commands 38
modifiers, hyphenation rules 7

N
note, explanation of 2
nouns

hyphenation 8
personification 16
verbizing 24

numbered lists, use of 12
numbers

basic rules 14
hyphenating 15
measurements 15
pages 35
punctuating 15
using numerals 14
when to spell out 14

O
once vs. after 25
operators, general rules 16

P
pages

cross-reference formats 36
numbering 35

parallel structure in lists 13
passive vs. active voice, use of 21
personification 16
phrases to avoid 23
plurals 18
prefixes, hyphenation 8
procedural lists, use of 12
punctuation

general rules 18
in lists 13
numbers 15

Q
quotation marks

general use 20
in cross references 36
single, use of 20

R
reference, explanation of 2
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right vs. correct or immediate 25

S
screen captures 41
sections, introductions 37
semicolons, use of 20
since vs. because, use of 21
Snagit settings 41
spelling out numbers, when to 14
subheadings 37
such as vs. like, use of 21
symbols 2

T
table of contents 35
tables

alignment 39
cell parallelism 39
cross-reference formats 36
formatting 38
introductions 37
titles 39
without lines 40

templates, ESI FrameMaker 35
terminology

alphabetical listing 26
ambiguous 25
colloquial 26
words to avoid 23

text formatting 35
that vs. which, use of 20
TIF files 41
title page 35
titles

capitalization 7
cross-reference format 36
format 20

trademarks
abbreviations 33
adjectival nature 33
general use 31
notation 32
third-party 32

type vs. enter or kind 25
typed text, formats 38
typographical conventions 2

U
user interface elements terminology 37

V
verbs

hyphenation 8
personification 16

voice, active vs. passive 21

W
warning, explanation of 2
we vs. I, use of 22
whether vs. if, use of 21
which vs. that, use of 20
words to avoid 23
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